PHOTOSHOP TOOLS AND THEIR FUNCTIONS
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Path Selection Tool (A )

Notes Tool (N )
Hand Tool (H)

Foreground Colar (Alt + Baksp)

Custom Shape Tool (U )

Eyedropper Tool (1)
Zoom Tool (Z)

Rectangular Marquee Tool (M ) il P Move Tool (V)
Lasso Toal (L) %, Huick Selection Tool (W )
Crop Tool (C ) " Slice Tool (K)
Spot Healing Brush Tool (J) P 73 Brush Toal (B)
Clone Stamp Tool (§) &b, Fo Histary Brush Tool (Y )
Eraser Tool (E) g E R Gradient Tool (G )
Blur Tool (R ) P Dodge Tool (O)
Pen Tool (P) f 3; : Horizontal Type Tool (T)
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Background Color (Ctrl + Baksp)

Huick Mask Mode (0 )
Change Screen Mode ( F)

Rectangular Marquee Tool (M)

Use this tool to make selections on your image, in a rectangular shape. This changes the
area of your image that is affected by other tools or actions to be within the defined shape.
Holding the [Shift] key while dragging your selection, restricts the shape to a perfect square.
Holding the [Alt] key while dragging sets the center of the rectangle to where your cursor
started.

Move Tool (V)
Use this tool to, well, move things. Usually you use it to move a Layer around after it has been
placed. Hold the [Shift] key to limit the movements to vertical/horizontal.

Polygon Lasso Tool (L)

Ok, this should be the Lasso Tool, but I use the Polygon Lasso a lot more often. Use this to draw
selections in whatever shape you would like. To close the selection, either click on the beginning
point (you’ll see the cursor change when you’re on it), or just double-click. When holding the
[Ctrl] key, you’ll see the cursor change, and the next time you click, it will close your selection.

Magic Wand Tool (W)

Use this to select a color range. It will select the block of color, or transparency, based on
wherever you click. In the Options Bar at the top, you can change the Tolerance to make your
selections more/less precise.

Crop Tool (C)

The Crop Tool works similarly to the Rectangular Marquee tool (see above if you have no short-
term memory). The difference is when you press the [ Enter/Return] key, it crops your image to
the size of the box. Any information that was on the outside of the box is now gone. Not
permanently, you can still undo.

Slice Tool (K)

This is used mostly for building websites, or splitting up one image into smaller ones when
saving out. It’s kind of an advanced tool, and since you’re in here for the basics, we’ll kind of
skip over it. Kinda makes you mad I made you read all that for nothing, huh?



Healing Brush Tool (J)

This is a really useful tool. Mildly advanced. You can use this tool to repair scratches and specs
and stuff like that on images. It works like the Brush tool (see below). You choose your cursor
size, then holding the [Alt] key, you select a nice/clean area of your image. Let go of the [Alt]
key and paint over the bad area. It basically copies the info from the first area to the second, in
the form of the Brush tool. Only, at the end, it averages the information, so it blends.

Brush Tool (B)

This is one of the first tools ever. It’s what Photoshop is based off of. Well, not really, but it’s
pretty basic. It paints one your image, in whatever color you have selected, and whatever size
you have selected. There’s a lot of options for it, but this is basic, so you don’t get to learn them.

Clone Stamp Tool (S)

This is very similar to the Healing Brush Tool (see above). You use it the exact same way,
except this tool doesn’t blend at the end. It’s a direct copy of the information from the first
selected area to the second. When you learn to use both of these tools together in perfect
harmony, you will be a Photoshop MASTA! Not really, it’s just less irritating.

History Brush Tool (H)

This tool works just like the Brush Tool (see above) except the information that it paints with is
from the original state of your image. If you go Window>History, you can see the History
Palette. The History Brush tool paints with the information from whatever History state is
selected.

Eraser Tool (E)

This is the anti-Brush tool. It works like an eraser (duh) and erases whatever information
wherever you click and drag it. If you’re on a Layer, it will erase the information transparent. If
you are on the background layer, it erases with whatever secondary color you have selected.

Gradient Tool (G)

You can use this to make a gradiation of colors. Gradiation doesn’t appear to be a word, but it
makes sense anyway. It creates a blending of your foreground color and background color when
you click and drag it. Like a gradient.

Blur Tool (R)
The Blur tool is cool. It makes things blurry. Click and drag to make things blurry. The more you
click and drag, the blurrier things get.

Dodge Tool (O)
This tool isn’t as crappy as the car brand. It’s actually used to lighten whatever area you use it
on. As long as it is not absolute black. Absolute black won’t lighten.

Path Selection Tool (A)
You use this tool when working with paths. Since this is all about the basics, I won’t go into
details. It’s related to the Pen Tool (see below) though.

Horizontal Type Tool (T)

It makes type. Or text. Or whatever you want to call it. You can click a single point, and start
typing right away. Or you can click and drag to make a bounding box of where your text/type
goes. There’s a lot of options for the Type Tool. Just play around, it’s fairly straight-forward.

Pen Tool (P)

I mentioned this tool above. It’s for creating paths, in which you would use the Path Selection
Tool to select the path. Paths can be used in a few different ways, mostly to create clipping paths,
or to create selections. You use the tool by clicking to add a point. If you click and drag, it will
change the shape of your path, allowing you to bend and shape the path for accurate selections
and such.

Rectangle Tool (U)
By default it draws a Shape Layer in the form of a rectangle. It fills the rectangle with whatever
foreground color you have selected. It’s pretty complicated, don’t hurt yourself with this one.



Notes Tool (N)

Like post-it notes, but digital. You can use this tool to add small little note boxes to your image.
These are useful if you’re very forgetful or if you’re sharing your Photoshop file with someone
else. I’'m pretty sure it only works with .PSD files.

Eyedropper Tool (I)
This tool works by changing your foreground color to whatever color you click on. Holding the
[Alt] key will change your background color.

Hand Tool (T)

You can really make short work of your job with the Hand Tool. It’s for moving your entire
image within a window. So if you’re zoomed in and your image area is larger than the window,
you can use the Hand Tool to navigate around your image. Just click and drag. You can get to
this tool at any time when using any other tool by pressing and holding the [Spacebar].

Zoom Tool (Z)

Pretty obvious what this tool does. It allows you to zoom into your image. Don’t be dumb, it
doesn’t actually change the size of your image. Hold the [Alt] key to zoom out. Holding the
[Shift] key will zoom all of the windows you have open at the same time. Double-click on the
Zoom Tool in the palette to go back to 100% view.

Foreground Color
These are your color boxes. Foreground (in the front) and Background (in the back). Click on
either one to bring up the color select dialog box.

PHOTOSHOP INTERFACE
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The Photoshop Toolbar The Workspace

Perhaps the most important element of the Photoshop interface is the toolbar. It contains
a bunch of icons that represent the different tools Photoshop offers to alter and create images.
These include tools for selecting specific areas of images, changing the colors of the image,
stretching, transforming, and erasing parts of an image, and many more.
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Various Photoshop Panels

Panels are also important features of the Photoshop interface.
All sorts of information is displayed in these panels, and
therefore they can get a little confusing. They display

Color

location information, tool options, and history, among other
things. If you ever lose track of a specific panel (they tend to
stack up), go to the windows menu and select that pane to
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Menus are probably the most familiar interface elements to a new Photoshop user. They

contain all sorts of options, but since there are not as visible as panes or the toolbar, they are
often only partially explored. I'll take time right now to go over the menus and give a brief
description to orient you to each.

File contains all of the stuff you’d expect it to, with a few extras including Import, which
deals with scanning, and Save for Web, which allows you to export a web-ready image
from your Photoshop file.

Edit is another familiar menu. In Photoshop, edit houses all of the expected options as
well as Fill & Stroke, and other image-altering functions.

Items on the Image menu effect a whole image, for the most part. Here you’ll find color
adjustments, size adjustments, and any other changes you need to make globally when
working with a Photoshop file.

The layer menu is similar to the image menu, but it contains options that effect only
current or selected layers. I’ll explain layers a little later, but for now, just understand that
an image in Photoshop consists of stacked transparent layers; options in the Layer menu
affect these pieces of the image rather than the complete image.

The select menu deals with selections you make. Selecting the specific parts of an image
you’d like to alter is a difficult part of working in Photoshop. This menu gives you some
options regarding selections, including the ability to save selections, reverse them, or add
to them. Learning the options on the selection menu can really save you some time.

The filter menu is probably what most people think about when they think about
Photoshop. The filter menu allows you to apply filters to any part of your image. These
filters include ways to change the texture of the image, with some potentially radical
results.

The view menu is where you change the view settings. You can use this to show and
display guidelines on the image, and to zoom in and out, among other things.

The window menu allows you to toggle back and forth between hide and show for each
interface element. This is the first place you should go if you lose track of a particular
window while you’re working.



o Last and least, of course, is the help menu. The help documentation isn’t so helpful, but
for some reason, this menu contains two nice features: resize image, and export
transparent image, which I’ll get to later.

The options bar, which is located directly underneath the menus, is a useful tool when
working with the different Photoshop tools. As you can see right now, when the selection tool is
in use, the options bar reflects the changes that can be made to how that specific tool operates.
Here, you have selection options, and style options, which includes the ability to make the
selection tool a specific size in pixels. When you switch tools, to the paintbrush tool for instance,
these options change. When a tool in Photoshop isn't behaving as you expect it to, the options bar
should be the first place you look to fix it.

The options bar

Some definitions to get you started:

.psd: A .psd file is the file format in which Photoshop saves documents by default. It is a multi-
layer document that retains its full editing options when saved. In many cases you will export
webgraphics from a .psd document.

layers: Photoshop documents are composed of layers, which can basically be described as single
transparent sheets which hold particular pieces of an image. These layers can contain images,
text, and vector graphics, and can be rearranged and grouped according to user needs. Layers are
controlled with the use of the Layers panel. Often times, when you find yourself frustrated with
Photoshop, it is because you are trying to perform operations on a layer that is not currently
selected. Simply click on the name of a layer in order to designate it as the current layer.
Whenever you add text to an image in Photoshop, the text appears on a new layer. You can
"merge down" layers to consolidate them, and "flatten image" to force the entire contents of the
image onto one layer.

Selections: Selections refer to regions in an image that will be affected by the various tools. A
selection in Photoshop is similar to a selection that you highlight in a word processing
application. Once you have selected an area, you can apply a tool to it, such as paintbrush, or
perform an operation such as copy or crop. Selections can be any shape and size; the shape
depends on which selection tool you are working with.

Your selection will apply only to the current layer. If that layer is empty in the region selected,
you will get an error message. When this happens, go to the layers pane and select the correct
layer.

Resolution: Resolution refers to the number of pixels in a full size image. An image with hi
resolution contains more information than an image with lo resolution, and therefore, one can
always convert a hi-res image to a lo-res image. However, because information is lost in the
conversion, the reverse is not true. If you were to increase the resolution of a lo-res image, the
result would be fuzzy.

Screen resolution is close to 72 pixels per inch, so if you are working with graphics to be viewed
only on screen, 72 should be fine. Depending on the printer you are using, you would want to
increase this above 72 for graphics that will be printed. 300 is usually an acceptable resolution
for images to be printed; 150 would be the lowest acceptable resolution for printing.

Image Size: Resolution should not be confused with image size, which is also expressed in
pixels. Image size deals with the actual number of pixels tall and wide an image is. For an idea of



how the two differ, go to Image Size in the Image menu, and plug in different numbers for image
size and resolution.

Color mode: Color mode refers to the types of colors you will be using in your image. CMYK
and RGB are the most important of these modes to be familiar with.

e (CMYK is the setting for images that will be printed to paper. The letters refer to the four
channels of color used to create every color available: cyan, magenta, yellow, and black.

o RGB refers to the three channel color mode suitable for images to be viewed on the web:
red , green, and blue.



